ZWCAD MFG 2025 Release Notes

Overview

The mechanical module of ZWCAD MFG 2025 primarily includes improvements

in 5 aspects: compatibility, accessibility, part library, drawing functionality and

specialized toolset. The specific details are as follows:

New Features
&Enhancements in the

mechanical module

Description

AutoCAD® Mechanical
Compatibility

It can accurately and completely read data in
AutoCAD® Mechanical drawings, such as frame,
title block, balloon, part reference, BOM, and
mechanical symbols like surface texture,
geometric tolerance, and welding symbol. Opened
drawings can be correctly displayed and freely
edited, so users can reuse historical drawings
easily after switching to ZWCAD MFG.

Expanded Multi-Language

\Versions

Besides Simplified Chinese, Traditional Chinese,
English, German, Japanese, and Korean versions,
Polish and Turkish versions have been added,
reducing the learning costs for corresponding

regional users.

Expanded Part Library

The existing GB, ISO, and DIN standards have
been expanded. Meanwhile, it has added standards
including JIS, KS, PN, CSN, UNI, AFNOR,
ANSI, BSI, CNS, EN, GOST, IS and TCVN,
allowing mechanical engineers from more
countries to enjoy the convenience brought by the
availability of standardized part libraries.

2D Hide

For situations where there are assembly

relationships between parts or graphical




occlusions, it allows quick hiding of background
graphics behind the outer contours of parts. This
eliminates ambiguity in graphical representation
and saves time in manually trimming background

graphics.

Part Reference

It added a part reference object named Zwmpartref
, providing a more concise way to label part
graphics in the model space. After entering part
attributes, they can be synchronously referenced in
the BOMs, reducing the workload of data

maintenance.

Scale Area

This function supports dividing the model space
into regions with different scales. Users can plot
appropriate engineering drawings in the model
space or layout by setting suitable length scales or

text scales.

Enhanced Moment of Inertia

Calculation

It optimized the efficiency and accuracy of inertia
moment calculations, and supports the calculation
of graphic objects including closed shapes with
holes, closed shapes with spline profiles,
disconnected discrete shapes, and shapes with
centerlines, allowing users to easily handle more

complex engineering calculation scenarios.

Deflection Calculation

It provides a deflection calculation tool that allows
engineers to quickly generate deflection lines and
calculation result tables after inputting necessary
parameters. This tool helps engineers predict the
deformation of beams under loads and optimize

structures.

Enhanced Design and Calculation

of Sprocket/Pulley

It provides a sprocket/pulley design tool that helps

users quickly complete the drawing of




sprockets/pulleys, the drawing of chain/belt links,
the length calculation of chain/belt, the dynamic
adjustment of sprockets/pulleys and chain/belt.
Additionally, national standards are embedded
when selecting parameters to help users easily
create drawings that comply with the required

standards.

The platform part of ZWCAD MFG 2025 primarily includes improvements in 4

aspects: 3D function, UI/UX, API, and industry modules.The specific details are as

follows:

New Features & Enhancements
in platform part

Description

Improvement of Efficiency in

Opening 3D Drawings

CPU capabilities were fully utilized to enhance the

efficiency of opening 3D drawings.

3D Object Display Improvement

It added "Conceptual™, "Realistic", "Shade of
Grey", and "X-ray" visual styles to provide diverse
visualization effects. The display efficiency of 3D
models has been enhanced for a smoother viewing

experience.

3D Gizmos

In the 3D visual style, objects can be conveniently
panned, rotated, scaled and transformed through

3D gizmos.

STEP File Import

It supports the import of 3D files in STEP format
(AP203 and AP214 versions).

Ribbon Redesign

A brand-new design of the ribbon, offering
features such as slide-out panels, dragging panels,
floating panels, and collapsed panels as icons, to

provide users with a highly customizable interface.

Panel Redesign

Stacked and auto-hidden panels provide users with
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a bigger drawing space. A new navigator allows an
easier interactive way of dragging and docking

panels.

Floating Documents Window

Document windows can be dragged out of the
main program as floating windows, so users can
open one drawing on another monitor for

reference.

FAS/VLX File Support

Compatible with AutoL ISP files created with
Visual LISP. supports direct loading FAS/VLX
files.

Point Cloud Improvement

It added 3 visual styles including "Intensity",
"Elevation”, and "Classification" and support

configuration to meet different scenario needs.

GIS Improvement

It supports the import of commonly used map
sources such as Bing Maps, and the import of
OGC standard map services. It also supports
setting markers in the map and setting insertion
points in the drawing, so the map can the drawing
can be quickly matched according to geographical

location.

Raster to Vector Conversion

Convert raster images to vector data to meet users'
needs for converting paper drawings into DWG

files.

Help Document Redesign

It supports filtering in the offline help document. It
added online help documents (Supported
languages: including Simplified Chinese,
Traditional Chinese, English, Russian, German,

Spanish, French, Japanese, Korean).

Revcloud Improvement

"Revcloud" has become the new CAD entity type.
Revcloud shapes can be edited quickly by dragging

grips.




It supports non-initial string matching, and sorting

Command Matching Method commands by frequency of use, providing users

Improvement with a more intelligent and convenient interaction
method.

Next, we have a detailed introduction to the new features and enhancements.

New Features & Enhancements in the mechanical module

1. AutoCAD® Mechanical Compatibility

It now supports the conversion for various custom entities in AutoCAD® Mechanical.
It can accurately and completely read data in AutoCAD® Mechanical drawings, such
as frame, title block, balloons, part reference, BOM, and mechanical symbols like
surface texture, geometric tolerance, and welding symbols. Opened drawings can be
correctly displayed and freely edited, so users can reuse historical drawings easily
after switching to ZWCAD MFG.

Besides supporting the conversion of AM frame, BOM, title block, and balloons in
the previous version, ZWCAD MFG 2025 added support for 10 types of custom
entities: part reference, surface texture, geometric tolerance, welding symbol, datum
target, datum identifier, taper and slope, feature identifier, leader note, and hole chart.
It also covers 8 standards: GB, ISO, DIN, JIS, ANSI, BSI, CSN, and GOST.

Supporting AutoCAD® Mechanical drawing formats: 2012~2018.




Figure 1. AutoCAD Mechanical drawing

2. Expanded Multi-Language Versions

Besides Simplified Chinese, Traditional Chinese, English, German, Japanese, and
Korean versions, ZWCAD MFG 2025 added Polish and Turkish versions, reducing
the learning costs for corresponding regional users and enhancing the competitiveness

of the product in the international market.

Supporiéd languages | New languages ‘

b"‘“l.)hﬁed Trn‘d!lwnnl English German | Japanese Polish Turkish ‘
Chinese | Chinese ‘
| ‘

Figure 2. New languages version

3. Expanded Part Library

The existing GB, ISO, and DIN standards have been expanded. Meanwhile, it has
added standards including JIS, KS, PN, CSN, UNI, AFNOR, ANSI, BSI, CNS, EN,
GOST, IS and TCVN, allowing mechanical engineers from more countries to enjoy
the convenience brought by the availability of standardized part libraries.

In each standard, it added common standard parts including features and steel profiles.

In some standards, it added common standard parts including shaft parts, features and
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flanges.
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Figure 3. Part library

4. 2D Hide

For situations where there are assembly relationships between parts or graphical
occlusions, it allows quick hiding of background graphics behind the outer contours
of parts. This eliminates ambiguity in graphical representation and saves time in
manually trimming background graphics.
It provides many methods for 2D Hide: Hide (Trim), Hide(Cover), Reference Clip
and Hide(Part Out), and can be applied to various object types: basic graphic
elements, block references & external references, text, annotations. It also supports
configuration of hidden layers and dashed lines, catering to different scenarios.
Hide(Trim)
It added the ZwmTrimHide command, which realizes 2D hide by trimming. Based on
the selected entity with closed outer contours, it can hide the obscured background
entity by solid trimming. In cases where the background entity has inner contours,

you can choose to filter the inner contour region.



Hide(Cover)
It added the ZwmCoverHide command, which realizes 2D hide by covering. Based on
the selected entity with closed outer contours, it can hide the obscured background
entity by generating regional coverage. 2D hide can be turned off by executing the

ZwmUnCoverHide command.

Figure 4.2D Hide

Reference Clip
It added the ZwmBlockRefClip command. It can clip block references/external
references by specifying polyline/circle/arc/ellipse/spline objects as clipping
boundaries. After clipping, it can flip the clipped region. 2D hide can be turned off by
executing the ZwmUnBlockRefClip command.

Hide(Part Out)
When parting out parts, you can choose the exported part as a foreground entity to

perform 2D hide on the background entity.
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Figure 5. Hide (Part Out)
2D Hide Configuration:

It added the ZwmHClipConfig command. It allows setting the outer contour layers for

foreground entities and the non-hidden layers for background entities, so users can

control the hidden scope from the aspect of layers. Additionally, it enables setting the

generation of dashed lines and the search accuracy of contour extraction.
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Figure 6. 2D Hide Configuration

5. Part Reference

It added the Zwmpartref command, providing a more concise way to label part
graphics in the model space. After entering part attributes, they can be synchronously
referenced in the BOMs, reducing the workload of data maintenance. Additionally,
balloon numbers based on the part reference can realize association among BOMs,

balloons, and part references.



Figure 7. Part Reference

6. Scale Area

This function supports dividing the model space into regions with different scales.
Users can plot appropriate engineering drawings in the model space or layout by
setting suitable length scales or text scales.
The new command ZwmScArea allows users to specify a specific area as the scale
area. It supports two types of scaling: length scaling and text scaling.
Length Scaling
Length scaling enlarges or shrinks geometry without touching the size of annotations.
Text Scaling

Text scaling enlarges or shrinks annotations without touching the size of geometry.
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Figure 8. Scale Area

7. Enhanced Calculation of Moment of Inertia

It has optimized the efficiency and accuracy of inertia moment calculations, and now
supports the calculation of graphic objects including_closed shapes with holes, closed
shapes with spline profiles, discrete shapes, and shapes with centerlines, allowing

users to easily handle more complex engineering calculation scenarios.

Closed shapes with

Simple Closed shapes : Disconnected Centerline
) spline = e
closed shape with holes : discrete shapes filtering
curve profiles
® ... ] ) BED =
ZWCAD MFG v v v v v
Autocad Mechanical v v X X X
BricsCAD Mechanical X X X X X

Figure 9. New scenarios supported by inertia moment.

11



Figure 10. Results of inertia moment calculation.

8. Deflection Calculation

It provides a deflection calculation tool that allows engineers to quickly generate
deflection lines and calculation result tables after inputting necessary parameters. This
tool helps engineers predict the deformation of beams under loads and optimize
structures.

In bridge design, users can calculate the deflection of the bridge under loads based on
parameters such as spans, loading conditions, and material properties, to assess the
bridge's load-bearing capacity and its safety. In mechanical design, users can calculate

the deformation of mechanical components to optimize structures and verify strength.
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Beam Calculation

Load Support Material
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Figure 11. Results of deflection calculation.

9. Enhanced Design and Calculation of Sprockets/Pulleys

It provides a sprocket/pulley design tool that helps users quickly complete the
drawing of sprockets/pulleys, the drawing of chain/belt links, the length calculation of
chain/belt, the dynamic adjustment of sprockets/pulleys and chain/belt. Additionally,
national standards are embedded when selecting parameters to help users easily create

drawings that comply with the required standards.

Sprocket/Pulley  Length Calculation Manual movement Chain/Belt Links

Figure 12. sprocket/pulley design tool

Drawing of Sprockets/Pulleys

It added the ZwmSprocket command. After specifying the inserting point, standard,
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dimension parameter, and some geometric features (such as number of teeth and shaft
diameter), it can quickly generate the required sprocket/pulley, and it can be directly

edited by double-clicking.

Sprocket x

Select dimension

ISO 606 - 058 - 1
—
— |\ ISO 606 - 081 - 1
(ﬁ Q) ISO 606 - 083 -
e 1SO 606 - 084 -
ISO 606 - 085 -
ISO 606 - 0BA -
ISO 606 - 088 -
ISO 606 - 10A -
ISO 606 - 108 -
IS0 606 - 12A -
ISO 606 - 128 -
ISO 606 - 16A -
Pitch9.53 [mm] 1S0 606 - 16B -
ISO 606 - 20A -
IS0 ADA - 208 -

menu

i T

ISO 606 - 068 - 1

Previous MNext Cancel
Figure 13. Sprockets/Pulleys design
Length Calculation of Chain/Belt Links

It added the ZwmChainLengthCal command. Select length calculation, specify the
standard and dimension parameter, select the tangent outer circle of the hub, then it

can quickly generate the required chain/belt polyline.

Model Layout1 Layout2

14



Figure 14. Length Calculation of Chain/Belt Links

Manual Movement of Sprockets/Pulleys
Execute the ZwmChainLengthCal command, select manual movement, move the
specified sprocket/pulley to any other position, and the chain/belt will dynamically
adjust accordingly. This function provides convenience for users in scenarios where
adjustment is needed after they complete the design of sprocket/pulley.

Drawing of Chain/Belt Links
It added the ZwmChainDraw command. Select the starting point, standard, and

direction of the chain/belt link, and it can quickly generate the required belt/chain

links.

EZ Chains - Geometry X

Geometry of Chain

Links to be drawn

= 20

Belt Arrangement

Unilateral
Unilateral

Bilateral - symmetry
Bilateral - Interleaved

Previous Complete Cancel

Figure 15. Drawing of Chain/Belt Links
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New Features & Enhancements in platform part
1. Improvement of Efficiency in Opening 3D Drawings

By fully utilizing CPU capabilities and leveraging multi-threading parallel
technology, we significantly enhanced the efficiency of opening 3D drawings in
ZWCAD. The efficiency of opening 3D drawings has been improved by

approximately 60% compared to the previous version.

2. 3D Object Display Improvement

More visual styles have been added to meet viewing or modeling needs in different
scenarios. The display quality and display efficiency of 3D models have been
improved.

New Visualization Styles
We added "Conceptual”, "Realistic”, "Shade of Grey", and "X-ray" visual styles and
optimized the display quality of visual styles including wireframe, hidden, shaded,

and shaded with edges.
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Figure 2. New 3D visual styles

Display Efficiency Improvement

We systematically improved the efficiency of viewing 3D drawings, including

panning, scaling, and 3D orbit.
3. 3D Gizmos

In the 3D visual style, objects can be efficiently and conveniently moved, rotated,
scaled. When the gizmo is selected, you can switch between moving, rotating, and

scaling by pressing the spacebar.
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Figure 3. 3D gizmos help users edit 3D entities more easily.

4. STEP File Import

STEP is an international file format in the mechanical industry. By supporting STEP
files import, the cost of file transfer from the design department to manufacturers can

be reduced.
Supported STEP Versions

It supports the import AP203 and AP214 versions of STEP files.
STEP Import Settings

It supports configuration of the import of STEP files, including destination location,

import method, and display settings.
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STEP Import Settings *

Target drawing Dizplay settings
() Currert drawing Wiew: SW |sometric w
(®) New drawing Visual style: | Shaded e
Impart method
(®) Import directly

() Specify inzertion point

[ ] Always perform my current choice Cancel Help

Figure 4. STEP Import Settings dialog.

5.Ribbon Redesign

The ribbon now includes new features such as slide-out panels, dragging panels, and

floating panels. Combined with CUI, it enhances the customization level of interface.
Slide-out Panel.

The panel can be expanded when you click on it and collapsed when you move the

mouse away from the slide-out area. You can also fix the panel by clicking the "Pin"

button on the left side to make it stay expanded or collapsed.

T EFRBRRTR -

Annotate  Insert  Views Tools
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NG C Y o

Line Polyline Circle Arc

-
- - - Bl - 3 -
.

5 Sketch Wipeout O Donut

[C] Region [M6] Super Hatch
- Draw «

Figure 5. Slide-out ribbon panel.

Dragging Panel

You can change the location of panels under the current tab on the Ribbon by clicking
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on the panel (skipping function icons) and dragging it to the desired location.
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Figure 6. Dragging ribbon panel

Floating Panel

You can drag the panel outside the Ribbon by clicking on the panel (avoiding function
icons) and dragging it to the desired location. The floated panel can be grouped with

others or collapsed.
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Figure 7. Floating ribbon panel
6. Panel Redesign

Panels can be stacked and hidden automatically, including Properties Panel, Layer
Properties Manager, External Reference panel, Design Centre, Tool Palette,
Calculator, helping users expand the drawing area.

Panel Stacking

When you drag one panel onto another, these panels can be stacked together. Whether

the panel is floated or docked, it can be combined with another panel in four
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directions: top, bottom, left, and right.
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Figure 8. panels stack together:

Panel Auto-Hide
When the panel is docked on the side of ZWCAD, click the "Auto-Hide" button in the

top right corner of the panel, and the panel will be hidden. You can choose to hide it

as text or icon.
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Figure 9. Different hiding methods
Navigator
When you drag the title bar of a panel, it will trigger the navigator between the panel

and the ZWCAD program. When you drag the panel to another panel, it will trigger

the navigator between them. The navigator can provide you with a more intuitive

preview effect.
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Figure 10. Stacking Navigator

7. Floating Document Window

Document windows can be dragged out of the program, so users can open one
drawing on another monitor as a reference drawing. When opening two or more
drawings in ZWCAD, users can drag any document out of the program by clicking on

the document tab and dragging it to the desired location.
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Figure 11. Drag a drawing out as a new window:.

8. FAS/VLX File Support

It supports the direct loading of standard LISP binary files in FAS and VLX formats.

It improves LISP compatibility, eliminates format conversion and enhances

development efficiency.

ZWCAD Applications (*.zn;".Isp v

Extension Application (*.zrx)

LISP Application (*.Isp)

LISP Encrypted Application (*.zel)
ZWCAD encry lisp execute file (*.zelx)
ZWCAD execute file (*.vis)

VBA Application (*.zvb)
Visual LISP executable file (*.vix)

Fast-load AutoLISP format (*.fas)

ZWCAD Applications (*.zr;*.Isp;*.zel;*.zelx;* vis;*.zvb)

Figure 12. Directly load FAS/VLX applications

9. Point Cloud Improvement

New Visualization Styles

It added 3 new visualization styles including "Intensity", "Elevation", and

"Classification". Also, users can configure point cloud colors.
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Figure 14. Elevation visualization style
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Figure 15. Classification visualization style

Navigate to Scan View
In the Point Cloud Manager, right clicking a subset will trigger a context menu.
Through the "Navigate to Scan View" function, and users can quickly locate the

corresponding view.

Figure 16. Navigate to the scan view to observe the interior of the building.
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10.GIS Improvement

This module has replaced the original ArcGIS module to import maps and represent

geographic features in ZWCAD.
Map Service Import

It provides multiple map services including Bing Maps. Users can add map services

compliant with the OGC protocol.

I3 Add Map X
Select map Basic Information
Map Source | All ¥ | Map Name Q Name: Road Map - Bing

Service URL: https://dev.virtualearth.net/REST/

Description: Global Road Map

Road Map - Bing Image Annotation Ma...

Label: BING
Coordinate 3857
g system:
s 1ad
Image Map - Tianditu Vector Map - Tianditu ~ Terrain Map - Tianditu Data range: Left: -20037508.34
o Sy e, 8 1
\\—*x F, ey Top: -20048966.1
‘i S ,.Arff /A
\\ % . PSP Right: 20037508.34
Topographic Note - Ar... Terrain Map - Arcgis World Map - Arcgis

Bottom: 20048966.1

| OK | | Cancel | l Help

Figure 17. Add Map" dialog box.

Locating Function
You can match the geographic marker with the insertion point specified in the

drawing by specifying the latitude and longitude.
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Figure 18. Visual representation of map and drawing matching

11.Raster to Vector Conversion

It supports converting raster images into CAD entities, allowing users to directly edit
and modify the converted drawings. This feature helps users reuse historic hand-
drawn drawings or scanned drawings, reducing the workload and cost of converting

them to CAD drawings manually.
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Hand-drawn drawing DWG drawing

Figure 19. Convert raster image to DWG drawing.

12.Help Document Redesign

It added an online help document and optimized the search engine for the offline help

document so users can access the help documentation service more conveniently.
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New Online Help Document
Online help document enables users to access the help document anytime, anywhere,
on any device, without the need to open the program (Supported languages: including
Simplified Chinese, Traditional Chinese, English, Russian, German, Spanish, French,

Japanese, Korean).

@ ZWCAD Help 'DC‘C.@I*DX

ZWSOFT

English

All Documents = Al Documents > ZWCAD Help > Express Tools > Draw > REVCLOUD Espafiol
REVCLOUD Frangais
ZWCAD 2025 EE==]
o 7 E E E E E -
Blocks h Button: Pycckuid AzsIK
Text - Ribbon (2D): Home » Draw » Rectangular, Polyg I, Freehand, Ellipse, Circle P
Dimension v Toolbar: Draw » Revcloud —
Selection Tools - Menu: Draw >» Revision Cloud » Rectangular, Polygonal, Freehand, Ellipse, Circle
Modify . Keyboard: REVCLOUD
5 Create a revision cloud that is composed of multiple connected arcs.
raw ~
BREAKLINE Starting point
REVCLOUD Specify the starting point of the revision cloud.
JOINL Arc length
ANGDIV Specify the arc length. The maximum arc length and minimum arc length that you specified are saved in the system
registry, and considered as default values when the command is used next time.
ARCCMP
CONZDASH
A NOTE The maximum arc length should be no greater than 3 times the minimum arc length.
CHGLTSCA
File Tools ~ .
Object
Tools ~
Convert the selected closed object (circle, ellipse, polyline, spline, etc.) to a revision cloud.
Keyboard v After an object is selected, you are prompted tc reverse the direction or not.
Othare -

© 2024 ZWSOFT CO,, LTD.(Guangzhou) All rights reserved. All other trademarks cited herein are the properties of their respective owners.

Figure 20. Online help document homepage

Offline Help Document Improvement
Offline help documentation supports filtering, enhancing the convenience and

efficiency of searching.
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ZWCAD 2025 Help

Q layer Y Output path
Canfigure Filtering Conditions: Enter the path to save CSV file, or click Browse button to specify it.
What's New Commands
Gap tolerance
System Variables  Express Toals
If there is a gap at the selected area boundary, set the maximum allowable distance between two points at the gap.
Installation and Registration
Developer Help Tolerance
X The default value is 0, and the value range is 0-5000.
User Guide
Knowledge Document Units and scale
Specify area units and conversion scale.
ATTEDIT
Area Table Dialog Box Convert from
BHATCH Set the drawing units.
€ Comman ds
CHAMEER Convert to
CHANGE Set the units for area dimensions.
CHPROP Ratio
CLASSICLAYER h . ; ; . .
Display the conversion scale from drawing units to area dimension units.
COLOR
COLOR Command Procedures Factor
Commands Convert the drawing area to the actual area, and the area dimension value will be scaled according to scale factor.
DGNEXPORT
DGNIMPORT Layer settings
£dit Attribute Dialog Box Specify the layer for area dimensicns and tables.
Contents Index Favorites  Result

© 1998-2024 ZWSOFT CO, LTD.(Guangzhou). All rights reserved.

Figure 21. Search criteria help users more accuracy to find the content.

13.Revcloud Improvement

Users often use revclouds for drawing review. Revcloud has become a CAD object
and command branches are expanded, facilitating the creation and editing of
revclouds.

Revcloud as CAD Object Type
In the past, the CAD object type for revclouds was "polyline™. In this version, it has
been changed to "Revision Cloud". Users can directly edit the shape of revclouds by
dragging its grips and can modify the arc length of revclouds through the properties

panel.
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Figure 22. New CAD object called "Revision Cloud."”
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Figure 23. Users can change the shape of revcloud with grips.

New Branch Commands
"Circle", "Ellipse"”, "Modify" commands are added so you can create circular or

elliptical revclouds. With the "Modify" command, you can edit the shape of existing
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revclouds.

Figure 24. New revcloud types

14.Command Matching Method Improvement

The command matching mechanism has been improved to provide users with a more

intelligent command interaction experience.
Command Match Improvement

In the previous version, it had prefix matching only. In this version, it added substring
matching, wildcard matching and fuzzy matching. Users can quickly locate the
required commands by entering certain characters or keywords of the command

without having to enter the full name of the command accurately.

I usT) I I INETLOCATION d: L (LINE)

:LINE : LINE

:usT : MLINE ele JER) MLINE
: LIGHT 8 : PLINE : PLINE

: LIMITS |- XLINE ouT) XLINE

LIMMAX SPLINE IN (INTERSECT)
LIMMIN LINESUM (1 YPE) U1 (LIST)

1] ine Command: 14 Tinr]

Prefix Matching Substring Matching Wildcard Matching Fuzzy Matching
Figure 25. Four Match Types

Intelligent Sorting

When users input a string, the commands will be sorted by the frequency of usage.

32



